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Soft Solutions, Inc. Software License 

 
1. License. The software, documentation and any fonts accompanying this License 

whether on disk, in read only memory, on any other media or in any other form (the 
"Soft Solutions Software") are licensed to you by Soft Solutions, Inc. or its local 

Distributor/Reseller, if any ("Soft Solutions"). You own the media on which the 

Soft Solutions Software is recorded but Soft Solutions and/or Soft Solution's 
licensor(s) retain title to the Soft Solutions Software. The Soft Solutions Software in 

this package and any copies that this License authorizes you to make are subject to 

this License. 
2. Permitted Uses and Restrictions. This License allows you to install and use the 

Soft Solutions Client Software as governed by the licensing set forth on the 4-Sight 

FAX Server software license. You may make copies of the Soft Solutions Software 
in machine-readable form for backup purposes only. The backup copy must include 

all copyright information contained on the original. Except as expressly permitted in 

this License, you may not decompile, reverse engineer, disassemble, modify, rent, 
lease, loan, sublicense, distribute or create derivative works based upon the Soft 

Solutions Software in whole or part or transmit the Soft Solutions Software over a 

network. You may not transfer your rights under this License including the related 
documentation. THE SOFT SOLUTIONS SOFTWARE IS NOT INTENDED FOR 

USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 

NAVIGATION OR AIRCRAFT COMMUNICATION SYSTEMS, OR AIR 
TRAFFIC CONTROL MACHINES IN WHICH CASE THE FAILURE OF THE 

SOFT SOLUTIONS SOFTWARE COULD LEAD TO DEATH, PERSONAL 

INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE. Your 
rights under this License will terminate automatically without notice from Soft 

Solutions if you fail to comply with any term(s) of this License. 

3. Limited Warranty on Media (if applicable). Soft Solutions warrants the media on 
which the Soft Solutions Software is recorded to be free from defects in materials 

and workmanship under normal use for a period of ninety (90) days from the date of 

original retail purchase. Your exclusive remedy under this paragraph shall be, at 
Soft Solutionôs option, a refund of the purchase price of the product containing the 

Soft Solutions Software or replacement of the Soft Solutions Software which is 

returned to Soft Solutions or a Soft Solutions authorized representative with a copy 
of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED 

WARRANTIES ON THE MEDIA INCLUDING THE IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF 

ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO NOT ALLOW 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 

LIMITATION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET 

FORTH HEREIN IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER 
ORAL OR WRITTEN, EXPRESS OR IMPLIED. SOFT SOLUTIONS 

SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES. THIS LIMITED 

WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION. 

4. Disclaimer of Warranty on Soft Solutions Software. You expressly acknowledge 

and agree that use of the Soft Solutions Software is at your sole risk. The Soft 
Solutions Software is provided "AS IS" and without warranty of any kind and Soft 

Solutions and Soft Solutionôs licensor(s) (for the purposes of provisions 4 and 5, 

Soft Solutions and Soft Solutionôs licensor(s) shall be collectively referred to as 
"Soft Solutions") EXPRESSLY DISCLAIM ALL WARRANTIES AND/OR 

CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF 
MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 

RIGHTS. SOFT SOLUTIONS DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THE SOFT SOLUTIONS SOFTWARE WILL MEET YOUR 
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REQUIREMENTS, OR THAT THE OPERATION OF THE SOFT SOLUTIONS 

SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 

DEFECTS IN THE SOFT SOLUTIONS SOFTWARE WILL BE CORRECTED. 
FURTHERMORE, SOFT SOLUTIONS DOES NOT WARRANT OR MAKE 

ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF 

THE USE OF THE SOFT SOLUTIONS SOFTWARE OR RELATED 
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, 

RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION 

OR ADVICE GIVEN BY SOFT SOLUTIONS OR A SOFT SOLUTIONS 
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN 

ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE 

SOFT SOLUTIONS SOFTWARE PROVE DEFECTIVE, YOU (AND NOT SOFT 
SOLUTIONS OR AN SOFT SOLUTIONS AUTHORIZED REPRESENTATIVE) 

ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE 

EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION 

MAY NOT APPLY TO YOU. THE TERMS OF THIS DISCLAIMER DO NOT 
AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER 

ACQUIRING SOFT SOLUTIONS PRODUCTS OTHERWISE THAN IN THE 

COURSE OF A BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY 
LIA BILITY FOR DEATH OR PERSONAL INJURY CAUSED BY SOFT 

SOLUTIONSÍS NEGLIGENCE. 

5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING 
NEGLIGENCE, SHALL SOFT SOLUTIONS BE LIABLE FOR ANY 

INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES 

ARISING OUT OF OR RELATING TO THIS LICENSE. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR 

CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT APPLY TO 

YOU. In no event shall Soft Solutionôs total liability to you for all damages exceed 
the amount of fifty dollars (USD $50.00). 

6. Export Law Assurances. You may not use or otherwise export or re-export the 

Soft Solutions Software except as authorized by United States law and the laws of 
the jurisdiction in which the Soft Solutions Software was obtained. In particular, but 

without limitation, the Soft Solutions Software may not be exported or re-exported 

(i) into (or to a national or resident of) any U.S. embargoed country or (ii) to anyone 
on the U.S. Treasury Department's list of Specially Designated Nationals or the U.S. 

Department of Commerce's Table of Denial Orders. By using the Soft Solutions 

Software, you represent and warrant that you are not located in, under control of, or 

a national or resident of any such country or on any such list. 

7. Government End Users. If the Soft Solutions Software is supplied to the United 

States Government, the Soft Solutions Software is classified as "restricted computer 
software" as defined in clause 52.227-19 of the FAR. The United States 

Government's rights to the Soft Solutions Software are as provided in clause 

52.227-19 of the FAR. 
8. Controlling Law and Severability. If there is a local subsidiary of Soft Solutions 

in the country in which the Soft Solutions Software License was obtained, then the 

local law in which the subsidiary sits shall govern this License. Otherwise, this 
License shall be governed by the laws of the United States and the State of Georgia. 

If for any reason a court of competent jurisdiction finds any provision, or portion 

thereof, to be unenforceable, the remainder of this License shall continue in full 
force and effect. 

9. Complete Agreement. This License constitutes the entire agreement between the 

parties with respect to the use of the Soft Solutions Software and supersedes all 
prior or contemporaneous understandings regarding such subject matter. No 

amendment to or modification of this License will be binding unless in writing and 

signed by Soft Solutions. 
This software package is covered by the XML-RPC C library License. Additionally, 

certain parts of this library are derived from pre-existing code, which may carry its 

own license. 
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Copyright (c) 1988-1997 Sam Leffler Copyright (c) 1991-1997 Silbutton Graphics, 

Inc. Libtiff.  IN NO EVENT SHALL SAM LEFFLER OR SILBUTTON 

GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 

OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 

WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, 

AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 

CONNECTION W ITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE. 

SOFT SOLUTIONS, INC. 

Copyright  2000-2010 Soft Solutions, Inc. World Wide Rights 

Reserved. 
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Welcome to 4-Sight FAX Client 

In this chapter: 

Topic Page 

Introduction 2 



Page 2 Welcome to 4-Sight FAX Client  

 

4-Sight FAX  Client v7.5  Soft Solutions, Inc.  

 

Introduction

4-Sight FAX allows you to send and receive fax messages from 

your Macintosh and PC. It has all the same features as previous  

4-Sight FAX versions, plus several new features designed to 

enhance the user experience and increase productivity. 

 Email to Fax: Send faxes from your email client through a 

simple, easy to use format 

 User personal save folder for incoming faxes 

 64-bit Print Driver Capabilities for Mac and Windows 

 Significant overall speed and performance increase.  

 XML/RPC updates 

 Smart notification for incoming faxes 

 Direct faxing of PDF, PNG, and TIFF file attachment, 

eliminating print driver requirement 

 

 Automatic end-user fax notification. 

 Document drag-and-drop faxing. 

 Apple Address Book support.  

 Convenient automated program update notification and 

installation. 

 View number of new messages from the MAC dock or 

Windows Taskbar. 

 User configurable/alternate port number preference for the fax 

server. 

 Line control for faxing. 

 Email Suite ï allows you to send and receive emails as PDF 

files. 

 Preview frame in the Fax Client window allows you to 

instantly view thumbnails of incoming and outgoing faxes. 

 Enhanced Fax Composer contains a variety of views when 

creating a new fax. This provides much larger viewing areas 

for recipients, attachments and comments. 

 SMTP authentication for added security when sending Email. 

 Send and receive faxes from your desktop. 

 Address grouping provides convenient contact list 

segmentation. 

 Customizable interface (font type, size, labels, default cover 

pages and messaging. 

 Client-side imaging, which eliminates the need to duplicate 

fonts and applications on the Fax Server. 

New 7.5 Client 

Features:  

Existing Features:  
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 Windows® Client software for; Windows 98, ME, 2000 and 

XP. Macintosh Clients for OS 9, and OS X. 

 Server and Client-based address books. 

 Remote access via TCP/IP ï where connecting to your fax 

Server is as close as an Internet connection. 

 Support for Direct Inward Dial.
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1. Installing 4-Sight FAX Client 

In this chapter: 

Topic Page 

Software Requirements 6 

Installation 7 

Upgrading from Previous Versions 8 
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Software Requirements 

 

4-Sight FAX Client for 

Macintosh 

4-Sight FAX Client for  

Windows 

Mac OS  

 9.23 

Mac OS X 

10.3 ï 10.6 

Windows 

98, and ME 

Windows 2000 

and XP, Vista, 

and 7(not 

compatible with 

Windows NT) 

96MB - 

128MB RAM 

256 MB 

RAM 

96MB - 

128MB 

RAM 

128MB - 256MB 

RAM 

20MB HDD 

space 

20MB HDD 

space 

20MB 

HDD space 

20MB HDD 

space 

Minimum Software 

Requirements  
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Installation 

1. Downloaded the 4-Sight FAX Client from the 4-Sight FAX 

website and copy it directly onto each machine that will run 

the Fax Client software. Launch the Installer locally. DO NOT 

run the Installer from another location or machine, such as a 

network file server. 

2. Double-click on the appropriate installation program. The 

installation program is based on the operating system you have 

installed. 

3. View the Read Me file and click Continue. 

4. Click Install . Files are copied to your local hard drive. 

5. Click Restart (OS 9) or Quit  (OS X).  

How to install 4 -Sight 

FAX Client  
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Upgrading from Previous Versions  

The installation program handles all upgrade issues. 

What's Next? 

Before you can start using 4-Sight FAX Client, you must configure 

your 4-Sight FAX client.  Chapter 2 details these procedures.   
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2. Configuring 4-Sight Fax Client 

In this chapter: 

Topic Page 

Getting Started 10 

Connecting and Logging into a 4-Sight FAX 

Server 

11 

Fine-Tuning Login and Notification Preferences 14 
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Getting Started 

1. The 4-Sight FAX Server must be installed and running on your 

network. 

2. A complete installation of 4-Sight FAX Client on your 

computer. 

3. A user login, with a name and password that was created for 

you on the 4-Sight FAX Server. Contact your network or 

office administrator for your login and password. 

Note: 

 You must know the public static external IP address of the 4-

Sight FAX Server if you are connecting to from outside your 

local area network (LAN). 

Three items that 

you MUST have in 

order to send  and 

receive faxes:  



Sending and Receiving Faxes Page 11 

 

Soft Solutions, Inc.   4-Sight FAX  Client v7.5  

Connecting and Logging into a 4-Sight FAX Server 

You must indicate to your 4-Sight FAX Client which 4-Sight FAX 

Server you want to use to send and receive fax messages. 

 

This dialog box appears if you do not have at least one 4-Sight 

FAX Client account (user) defined, such as when you launch 4-

Sight FAX Client for the first time, or if you have deleted all 

accounts on this machine. 

Note: 

 See How do I? on page 12 for more information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page 12 Sending and Receiving Faxes 

 

4-Sight FAX  Client v7.5  Soft Solutions, Inc.  

12 

 

 

Do the following to continue: 

Click é Toé 

New 

Account 

Create an account for this 4-Sight FAX Client 

running on this machine.  Select your account name 

by choosing the fax server from the 4-Sight FAX 

Server list. 

This can be the same or different from your 

username. 

Work 

Offl ine 

Create faxes now.  4-Sight FAX Client 

automatically puts them into the Pending folder.  

When you connect to the 4-Sight FAX Server, you 

can send the faxes immediately or schedule them 

for a later time. 

1. Click New Account to: 

 Select the 4-Sight FAX Server you want to use to send and 

receive faxes. 

 Select your user name that was created for you by the fax 

administrator for the FAX Server you selected. 

How do I?  
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2. Select the FAX Server you want to use from the Fax Servers 

list. 

 

3. Select Get Users and then select your name from the User 

Name list.  Decide from the following options: 

Option Description 

Account 

name 

Decide how you want your name to appear on your 

window when you login. 

Remember 

password 

Allows the Fax Client to remember your password so you 

are not asked for it each time you log into 4-Sight FAX 

Client. 

Password Enter the password that was assigned to you when logging 

into the selected FAX Server. 

Login 

automatically 

Allows the Fax Client to automatically log you into the 4-

Sight FAX Server when you launch the client. 

4. Click Create. 

5. Select your user name from the Folder List. 

6. Click the  icon to start. 
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Fine-Tuning Login and Notification Preferences  

Use the Account Settings dialog box to define the following: 

Tabé What you can configureé 

Account  Display user name. 

 IP Address and Port of the 4-Sight FAX Server. 

 Alias. 

 Login options. 

Options  The default folder to view when you login. 

 Show faxes for all users.  (If you have the 4-Sight FAX 

Server privilege.) 

 The default cover page to use when sending faxes. 

 View which options and features are currently available. 

Email  Fax Forward to Email option. 

Notification  How often (in minutes) the FAX Client should check the 

FAX Server for new messages. 

 Whether or not you want to be notified when you receive 

or send a fax. 

 Allow notification of activity for either all or only your 

outgoing or incoming messages. 

 Notification method, either a pop-up window, sound or 

both. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, and then from the 

Windows pull-down menu, select Properties. 

3. Click the Account tab. You can configure the following: 

 Click Apply when done. 

Option Description 

Name Decide how you want your name to appear when you 

login. 

Server Displays the current 4-Sight FAX Server you are 

using to send and receive messages. 

Address You can view or change the current IP address of  4-

Sight FAX Server you are using to send and receive 

messages. 

Port You can view or change the (communication) Port 4-

Sight FAX Server is currently using.  The default is 

port 8008. 

The Account Tab  

How do I ?  
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Option Description 

User Name You can view or change your user name. Changing 

this can cause login failure problems if it does not 

match the user name listed on the Fax Server. 

Alias Enter or select an alias (alternate display name) when 

sending faxes. 

Remember 

Password 

Allows the Fax Client to remember your password so 

you are not asked for it each time you log into 4-Sight 

FAX Client. 

Password Enter the password that was assigned to you when 

logging into the selected FAX Server. 

Login 

automatically 

Allows the Fax Client to automatically log you into 

your account displayed in the Folder List  when you 

launch the client. 

 

Notes: 

 If you selected Remember Password and/or Login 

Automatically, changes will take affect the next time you 

launch 4-Sight FAX Client.  

 To automatically log into the selected 4-Sight FAX 

Server when you launch the application, select BOTH the 

Remember Password (even if you have not defined a 

password) and the Login Automatically  options.  

 IP Address and Port Number can only be changed when 

you are logged out of the fax server. 

 Changing your User Name can create login problems if 

this does not match is the user name set up on the Fax 

Server. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Options tab. You can configure the following: 

 Click Apply when done. 

 

Option Description 

Login Folder You can decide which queue (incoming, or outgoing) 

you want 4-Sight FAX Client to display when you login.  

Show faxes for 

all users 

Allows you to view all incoming and outgoing faxes 

from all users on this FAX Server,  

Note: 

The Options Tab  

How do I ?  
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Option Description 

 You can only view faxes for all users if you have 

the Full Queue Access feature enabled on the Fax 

Server. 

 

 

Option Description 

Default cover 

page 

Allows you to define a default cover page to use when 

sending messages.   

Note: 

 You can change which cover page you want within 

the Fax Composer. 

Default Fax 

Line 

Allows you to select a different fax line, if this FAX 

Server has more than one fax line. The default is Next 

Available. 

Phone Card Allows you to configure a default phone card number to 

use when accessing the 4-Sight FAX Server from a 

remote location, such as from a hotel, bypassing the 

additional hotel phone and toll charges. 

Privilege/Value Displays which options or features are currently 

available or not available. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Email tab. You can configure the following: 

 Click Apply when done. 

 

Option Description 

Enable fax 

forwarding 

to email 

Enable this feature to receive an Email with the fax 

attached as a PDF file. 

Note: 

 You must purchase the òEmail Suiteò feature 

separately.  

The Email Tab  

How do I?  
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Option Description 

Email 

Address 

(Incoming) 

Enter your Email address where you receive Email 

messages. 

Email 

Address 

(Outgoing) 

Enter the Email address where you want messages 

forwarded.  Faxes are sent to this email address in PDF 

format.  

 

 

1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Notifications tab. You can configure the following: 

 Click Apply  when done. 

 

The Notification Tab  

How do I ?  
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Option Description 

Show 

notifications 

of activity 

Allows you to receive notification (either by a pop-up 

window, sound or both) that either a fax has been 

received, or that a fax has been successfully sent, failed 

or rejected. 

Refreshes the 

queues every 

_ minutes 

You can define, in minutes, how often you want the 4-

Sight FAX Client to check the 4-Sight FAX Server for 

any new activity (incoming and outgoing). 

Give me 

notification 

of: 

Depending on your FAX Server defined user rights (Full 

Queue Access) you can either receive notification on 

Allé activity or just your own (Myé) 

Outgoing - All faxes sent successfully, failed or rejected 

by the intended recipient 

Incoming ï any new faxed received.  

Option Description 

Notification 

method 

You can receive either a pop-up message window, 

computer sound or both when an activity occurs for the 

selected account. 

 

Logging In from Outside Your Local Area Network (LAN)   

4-Sight FAX Client and the Fax Server communicate with each 

other using the TCP/IP protocol. Because of this, you are able to 

log into the Fax Server from anywhere in the world using a Client 

computer that has Internet access. The computer on which the Fax 

Server is running must have a static public (external) IP address. 

The procedure for setting up this type of login is the same as if you 

were logging in from within your LAN.  

 

Whatôs Next? 

Review the following sections for more information about sending 

and receiving faxes, managing your address books and working with 

the queues and folders. 

To doé See pageé 

Sending Faxes 24 

Receiving Faxes 42 

Viewing Faxes 43 
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To doé See pageé 

Working with Address books 52 
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3. Sending Faxes 

In this chapter: 

Topic Page 

Sending Faxes 24 

About Attachments 28 

Including Attachments 28 

Scheduling a Fax 30 

Resending a Fax 32 

 

Sending a Private Fax 

32 

Forwarding a Fax 33 

Rejecting a Fax in Transit 37 

Suspending (Holding) a Fax 37 

Releasing a Suspended Fax 37 
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 Sending Faxes 

The process of sending a document as a fax is a 5-step process: 

Step Process Description 

1 Create a fax 

document 

Create a fax document from most any application, 

or resend/forward an existing fax from within 4-

Sight FAX. 

2 Convert 

document into a 

format suitable 

for faxing. 

If you are creating a fax message from within an 

application (other than 4-Sight FAX), your 

document is converted into a format suitable for 

faxing ï a group 4 TIFF image file. This is done 

via the 4-Sight FAX Print Driver. 

If you are creating a fax within 4-Sight Fax, there 

is no need to convert the document into a fax 

format, unless you include attachments. 

3 Select recipients 

and fax details 

This is where you can select your recipients, 

cover page and include attachments you want to 

in the message. You can also schedule to send the 

message at a later time.  Depending on which 4-

Sight FAX Client option you have installed, you 

can decide to send the message as a fax, an Email, 

or both at the same time. 

Note: 

 You must purchase the Email Suite to send 

and receive faxes as Emails. 

4 The fax is sent to 

the 4-Sight FAX 

Server 

The following happens: 

The selected cover page is attached to your fax, 

along with the appropriate information, such as 

name of the contact, etc. 

The fax is placed in the outgoing queue for 

transmission. 

5 Notification Depending on when you scheduled the 4-Sight 

FAX Server to send your fax, you can receive an 

automatic notification of the status of your fax. 

 

Note: 

 You must be logged into the 4-Sight FAX Server to send a 

fax.  If you are not connected to a Fax Server, the fax is 

placed in your Pending folder.  You will have the option 

to send the fax the next time you connect to a 4-Sight 

FAX Server. 

 

How  it all works:  
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1. Using the table below, decide how you want to send a fax. 

Send From... Description... 

Most 

applications 
 OS 9.x: If the 4-Sight FAX printer driver is not the default, 

press the <option> key, point to the File menu, and select 

Fax.  

 OS 10.x/Windows: If the 4-Sight FAX print driver is not 

the default, go to the File menu, and select Print . Select 4-

Sight FAX from the printer list.  

 If the 4-Sight FAX printer driver is the default, point to the 

File menu, select Print .  

Proceed to step 2. 

Within  

4-Sight FAX 
 To create a new fax, click the New Fax button   . 

 To Resend an existing fax message (Outgoing queue only), 

click the Resend button . 

 To Forward an existing fax message (Incoming queue, 

Outgoing queue, Sent Faxes and Personal Folders), click the 

Forward button . 

Proceed to step 2. 

Outside of  

4-Sight FAX 
Drag and drop documents onto the 4-Sight FAX Client icon on 

your desktop, or the OS X dock. Multiple documents can be 

dragged onto Fax Client together if you wish to include them in 

the same fax document. 

Proceed to step 2. 

How do I?  
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2. Click the Recipients tab.  Select the recipients from the Current 

Address Book section.  

 You can choose individual contacts and groups from your 

personal Client-based address book, from a Server-based 

address book, or from the Apple Address Book  (OS X 

only) if one is available (Server-based contacts are 

indicated by a blue bullet in the Name column.) You can 

also enter your own recipients, one at a time, in the Quick 

Entry fields.   

To... Do the followingé 

Include a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

Remove a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

Include a 

contact that is 

not in your 

address book 

Click the Quick Entry  icon.   

You must provide the contactôs Full Name and Fax Number.  

You can also include the Company Name and Email address.  

These entries will not be added to your address book. 

Note: 

 The Fax Serverôs Smart Dialing feature does not apply to 

any fax numbers you enter in the Quick Entry fields. Be 

sure to enter these numbers exactly as they should be 

dialed, including a ñ1ò if long distance, or any codes and 

prefixes required for international dialing. 

 

5. Click the Cover Page tab and select or enter the following: 

 Decide if you want to send this fax as the currently 

logged-in user name or as another user from the pull-

down menu next to Sender. 
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 Decide if you want to send this message as a Fax, Email 

or both.  You must have purchased the Email Suite to 

send messages as Emails. 

 Select the Cover Page you want to use. 

 Enter a Subject for this fax message. 

 Assign a Priority  to this fax message. 

 Decide if you want to send this message as a Private Fax.  

Select this option if you do not want anybody to see or 

have a record of this message. You must have permission 

from the Administrator to send Private faxes. 

6. Use the following chart to continue your setup: 

To... You must... 

Provide 

additional 

comments 

Select a Cover Page to include additional comments. Enter 

your comments in the Comments text box.  

Tip: 

 Click on the Annotation tool icon  to include 

additional mark-ups. See Annotating Messages on 

page 46 for more information. 

Include any 

attachments Click the Attach button . You can attach multiple 

documents to the fax message, but only one document at a 

time. 

See Including Attachments on page 28 for more 

information. 

Insert Data 

into Billing 

Fields 

If your Administrator has activated any of the three 

customizable Billing Fields on the Fax Server, these will 

appear under the Comments section. Complete the 

information for each field as required. 

7. Click the Options tab and select from the following options: 

 Decide which Fax L ine you want to use to send your fax.  

This option is useful if more than one fax line is available 

and if one fax line is unavailable or busy and unable to 

send your fax now. 

 Decide if you want to make use of your Phone Card to 

send this message. 

 Decide when you want to Schedule your fax to be sent.  

  Click Send Now to allow 4-Sight FAX Server to 

process and transmit the fax immediately. 
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 Click Send Later to schedule 4-Sight FAX Server to 

send the message at a later time.   

8. Click Send . 

About Attachments 

An attachment is a printable file that is appended to your fax 

message. Attachments always follow the cover page, if one is used. 

A printable file is practically any file from a word processor, 

spreadsheet or graphics program that you can print to a printer. 

Executable and JAR files are examples of non-printable files. 

Use attachments to include additional information that you would 

otherwise have to send as a separate message. Attaching a 

document allows you to quickly send information such as letters, 

charts, pictures or other documents as faxes. 

Within the Composer, click the Attach button  and select the 

printable files, one at a time, to include with the fax. You can 

include as many attachments as you want. Each file attachment is 

converted into a fax (TIFF) image file on your local computer and 

appended to the end of the fax. If you attach more than one file to 

the fax, the attachments appear in the order they were selected.  

Including Attachments 

 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Prepare a fax for sending. See Sending Faxes on page 24 

for more information. 

What is an 

Attachment?  

Why should I use 

Attachments?  

How do  

Attachments work?  

How do I?  
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3. Click the Attach button  to locate a document to 

include in this fax. Click Open.  

The document is opened in the application that was used 

to create it, or the currently selected default application 

for that file type. Although a print command is 

automatically issued using the 4-Sight FAX printer driver, 

you must select the print range and click Print . The 

document is then converted into an image file suitable for 

faxing. The file is attached to the fax message. You can 

preview the attachment(s) in the viewer section of the 

Compose New Fax Window, under the Fax Details tab.  

4. When done, click the Send button.  

Notes: 

 If your machine does not have the appropriate 

software to open and print the document or file, then 

you cannot include it as an attachment. 

 You can add as many documents as you want, but 

only one at a time. 
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Scheduling a Fax 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Use the following chart to continue scheduling: 

From theé Follow these steps: 

Outgoing Queue  Access the Outgoing Queue and 

select a fax, with a status of 

Waiting  that you want to schedule 

for some time in the future. 

 Click the Edit  button . 

 Click the Options tab. Proceed to 

step 3. 

Pending Faxes  Access the Pending Queue and 

select a fax that you want to 

schedule for some time in the 

future. 

 Click the Edit  button . 

 Click the Options tab. Proceed to 

step 3. 

Fax Composer Click the Options tab.  You can decide 

the following: 

 Send Now  

 Send Later . Proceed to step 3.  

How do I?  
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3. Select a different time and date (year, month, and day) to 

send the message. 

4. Use the following chart to continue: 

From theé Follow these steps: 

Outgoing Queue Click Apply . 

Fax 

Composer/Pending 

Faxes 
Click the Send button . 

 












































